## Contents

**Introduction** ................................................................................................................. 4

AEI’s role and goals................................................................................................................... 4
What AEI does ........................................................................................................................... 4
Policy development and advice ................................................................................................. 4
International and government-to-government engagement .................................................. 4
Quality assurance and consumer protection ......................................................................... 4
Qualifications recognition ....................................................................................................... 4
Market research and analysis ................................................................................................. 4
Stakeholder engagement ....................................................................................................... 5
Student mobility .................................................................................................................... 5
About this guide .................................................................................................................... 5
Prerequisites .......................................................................................................................... 5
Guide objectives .................................................................................................................... 5

**The AEI Online website** ................................................................................................ 7

Navigating to the AEI data ...................................................................................................... 7
International student data ...................................................................................................... 9
Other Reports and Statistics ................................................................................................. 10
  Monthly Time Series of Student Enrolments—Summaries by Sector ................................ 11
Pivot Tables .......................................................................................................................... 12
  Downloading AEI pivot tables and using Zip files .............................................................. 12
  Detailed Monthly Tables (PDF and Excel formats) ............................................................ 14
Other Useful Information on the AEI website ....................................................................... 15
  Research and Market Data Snapshots .............................................................................. 15
  Research papers ............................................................................................................... 15
Using Pivot Tables in Excel .................................................................................................... 15
Understanding Grouping ....................................................................................................... 15
Structure of a Pivot Table ....................................................................................................... 17
  Fields ................................................................................................................................. 17
  Page Area ........................................................................................................................ 18
  Data Area ........................................................................................................................ 18
  Row Area ........................................................................................................................ 18
  Column Area .................................................................................................................. 18
  Pivot Table Field List ....................................................................................................... 19
Using Fields to summarise data .............................................................................................. 20
  Moving Fields .................................................................................................................. 20
  Stacking Fields ................................................................................................................ 20
  Filtering Data .................................................................................................................... 21
  Drill Through .................................................................................................................... 23
  Sorting Items and Data ..................................................................................................... 23
Summarising Data in Pivot Tables ........................................................................................ 24
Creating and using Pivot Charts ............................................................................................ 28
Interpreting Data in Pivot Tables .......................................................................................... 31
Copying Data from Pivot Tables ........................................................................................... 33
Introduction

AEI’s role and goals

Australian Education International (AEI) provides leadership across all levels of government and industry to support the sustainable development of a world-class and globally connected international education and training system in Australia.

As the international arm of the Australian Government’s Department of Education, Employment and Workplace Relations (DEEWR), we are well placed to work with governments and industry to realise for Australia the intellectual, cultural, economic and security benefits of internationalisation.

We seek to achieve this goal through an integrated approach to policy, regulation, international engagement and promotion.

We encourage and facilitate Australian activity through our national office in Canberra and 25 offices in Australian diplomatic missions in 17 economies.

What AEI does

Policy development and advice

With strong links to all education sectors and all levels of government, AEI provides a national focus for debate and policy development.

International and government-to-government engagement

AEI represents Australia’s interests in international and multilateral bodies, and in negotiating agreements with governments around the world. We work with state and territory governments to coordinate international education policy and practice.

Quality assurance and consumer protection

Through the Education Services for Overseas Students (ESOS) legislation, AEI helps safeguard the quality and reputation of Australia’s courses and institutions. We administer world’s best practice in student consumer protection.

Qualifications recognition

AEI provides information on how Australian and overseas qualifications compare, and helps overseas qualified people study and work in Australia.

Market research and analysis

AEI produces research and analysis to provide industry with intelligence and advice on education markets around the world.
Stakeholder engagement
Through comprehensive stakeholder engagement, its international network and its communication tools, AEI makes sure the world knows about the quality and diversity of Australian education.

Student mobility
AEI supports student and professional mobility into and out of Australia through Endeavour Award scholarships, subsidies and international representation.

About this guide
This guide was developed by AEI’s International Research and Analysis Unit (IRAU).

The purpose of this guide is to assist the Australia international education industry to understand the publicly available International Student Data released by AEI. The guide will also provide information on how to manipulate the data using the Pivot Tables published on the AEI Online website.

The AEI data is published in the AEI Online website in a series of pivot tables (Microsoft Excel files). The data provides an up-to-date time series from 2002 to the current month of onshore enrolments by international students studying in Australia on a student visa. The data is updated monthly and is generally available within six weeks of the end of a reporting month.

Prerequisites
A working knowledge of Microsoft Office Excel is required to use the AEI pivot tables. Excel versions from 2003 provide the greatest range of pivot table options. Pivot tables will work on earlier versions of excel, but not all options will be available. Pivot tables are supported by Apple Macintosh versions of excel, but some of the functionality may be different to the windows version and some options may not be available.

Note: AEI continually develops and improves the Pivot Tables. As a result pivot table content may change without notice.

Guide objectives
Once you have completed this guide you should:

- Be able to find the data on the AEI website
- Understand the source of the data
- Understand how the data are derived
- Be able to extract data from the AEI Pivot Table on the AEI website
- Be aware of the various AEI statistical products.
Throughout this manual you will see activities designed to guide you through the course. These are formatted as in the example below:

⇒ **Open the AEI website in your browser.**

If you are viewing this manual electronically, there are many links embedded into the file you can click on to take you to web pages.

If you are viewing this manual as a hard copy, simply copy the link details into the address bar of your internet browser.
The AEI Online website

Before you start using the AEI data, familiarise yourself with the AEI Online website:

www.aei.gov.au

⇒ Click the link above to open the AEI Online website in your browser.

This website is AEI’s portal for disseminating market intelligence on international student activity, and includes the range of AEI statistical material. As well as pivot tables, the website includes many reports, newsletters, explanatory notes and snapshots of AEI data.

Navigating to the AEI data

The screenshot below is the AEI Online home page (as at September 2008). It may not look exactly like this when you open the page, but the panel on the right should be there with the link to International Student Data.

⇒ Click the International Student Data link indicated below.
From the AEI Statistics main page, you can access a range of AEI statistical material, including:

- International Student Data
- Research Snapshots
- Market Data Snapshots
- other useful research material.

The WHAT’S NEW box at the top right has a link to the most recent pivot tables.

There is a Search link on the AEI Online website. The screenshot below highlights this:
International student data

The International Student Data page includes:

**Monthly Summaries of International Student Enrolment Data**

- These summaries are published monthly and provide a commentary on the latest AEI data and trends.
- They are available as PDF files (requires Acrobat Reader), or as RTF files (requires Microsoft Word or similar).
- Reports are available for elapsed months of the current year and for months of previous years by clicking the year links.
Other Reports and Statistics

International Student Data

International student data are provided for 2002 onwards. These include enrolment data by month, and data on commencements and cessations of enrolments, as well as annual summaries. The data are depicted in a number of ways with several tables being available for free. More detailed information can be accessed through AEI's Market Information Package (MIP) or generated on a fee-for-service basis.

- 2008
- 2007
- 2006
- 2005
- 2004
- 2003
- 2002

[Return to Top]

Final Annual International Student Enrolment Statistics for 2000 and 2001

- Year 2001 Final International Student Enrolments
- Year 2000 Final International Student Enrolments

[Return to Top]

Explanatory Notes

- Explanatory notes for AEI International Student Data

[Return to Top]

Other Statistical Sources

- Link to Education Resources on the Australian Bureau of Statistics Website
- Department of Immigration and Citizenship
- English Australia

[Return to Top]

- These links lead to the monthly pivot tables for the current year and for previous years. Data for previous years can be accessed by clicking on the year of interest.
- They also provide a suite of detailed data from 2002 onwards, by a range of variables including Nationality, State, Sector and Month.
- The Explanatory Notes clarify common data related terms such as enrolments, commencements, nationality, sector, provider type, level and field of study, counting methodology, and describe AEI data sources.

⇒ Click the link under International Student Data to the current year.
Monthly Time Series of Student Enrolments—Summaries by Sector

The following tables give a month by month analysis of international student data by sector including information on enrolments, commencements, finishes and year to date totals. More detailed data are contained in the 2008 Detailed Monthly Tables section below.

Changes to the monthly data
AEI has made some changes to AEI international student enrolment data to enhance the usefulness of the data to industry.

In response to industry feedback about the reliability of current finishes data, these data have been removed from Tables 3 to 6. AEI will investigate whether a more accurate indicator can be used to determine the reason for an enrolment ceasing.

Please click on the images below to view the tables individually or a full set of the tables (1 to 6) PDF file (1.3MB) are available to download.

Table 1: All Sectors
Table 2: FLICOS
Table 3: Higher Education
Table 4: VET
Table 5: Schools
Table 6: Other

These tables give a month by month analysis of international student enrolments and commencements by sector, and for all sectors combined. You can either:
- Click on the charts individually to view them in a new browser window, or
- Click the tables 1 to 6 link highlighted in the red box above. This opens a freely available PDF file containing data and charts of AEI data up to the current reference month.
Pivot Tables

The Basic Pivot Table

- is available for free to all users of the internet
- contains a limited number of variables, but provides sufficient information to understand the major trends in Australia’s international education enrolments and commencements since 2002.

The Standard Pivot Table and Detailed Pivot Table

- contain additional variables as detailed in the boxes to the right of the links
- Access to these files is restricted to subscribers to the Market Information Package (MIP).

Downloading AEI pivot tables and using Zip files

Notes:
This part of the manual applies to computers using windows operating systems only. WinZip must be installed on the destination computer.

The excel files available on the AEI website are converted into zip files.
A zip file is a contains all the information in a normal file, but is a fraction of the size of the normal file. This minimises the space the file takes up on the AEI server and reduces the volume of data that is downloaded.

When you download a pivot table file off the AEI website, the file needs to be “unzipped” or uncompressed before it can be used. WinZip is the program used to do this.

To download, unzip and use AEI pivot tables:

- Navigate to the AEI website page with the pivot tables
- Click the pivot table for downloading. In this example it’s the Basic Pivot Table

The dialogue box below opens:

![File Download Dialogue Box]

- File name: 2008_Basic_Pivot.zip
- Type: WinZip File, 7.41MB
- From: aei.gov.au
- Option: Always ask before opening this type of file

While files from the Internet can be useful, some files can potentially harm your computer. If you do not trust the source, do not open or save this file. What’s the risk?
Click Open. This will activate WinZip:

The pivot table file can be seen in the WinZip window.

To unzip and open the pivot table file, just double click the file name. The file will automatically unzip and open.

**Detailed Monthly Tables (PDF and Excel formats)**

2008 Detailed Monthly Tables

The detailed monthly tables expand on the information provided in tables one to six. These tables include information on monthly enrolments, commencements and year to date data. Monthly data adds new enrollments for the month to the number at the start of the month.

Tables 7 to 12 contain information about each sector by top 10 Nationalities and State and Territory. The focus of these tables has changed from counting the enrolment and commencement activity during the reference month to counting the year to date activity up to and including the reference month.

The data in the following tables is updated throughout the year resulting in some revision to previously published data.

**Note:** Items marked with (*) are available only to organisations who have access to AEI’s Market Information Package (MIP). For non-MIP clients access arrangements are outlined in Accessing AEI Monthly Statistics.

⇒ Click the link to the most recently available Tables 7 to 12.
Note: PDF files required Adobe Acrobat Reader to open. This can be downloaded at:
www.adobe.com

Other Useful Information on the AEI website

Research and Market Data Snapshots
The Research Snapshot series was developed to provide stakeholders with one-page summary updates on current activities and developments in international education data and research. The series provide examples of the ways in which Detailed Pivot Table data can be manipulated to meet an individual users needs.

Similarly, Market Data Snapshots present a one-page summary of market-specific data together with local insights from AEI’s International Network to help explain trends in enrolment data from overseas markets.

Research papers
A number of research papers have been developed by AEI to provide international education industry stakeholders with the findings of more detailed analysis of AEI’s international student database.

Using Pivot Tables in Excel
Pivot Tables are a powerful, yet easy to use, data analysis tool that enables you to reorganise, filter, group and summarise data by dragging and dropping variables into and out of a table.

The data can be located within the excel file itself, or the pivot table can be linked to an external data source such as an Access database.

In this part of the manual some of the information is presented as text and images, and other information is presented in the form of exercises.

Understanding Grouping
Before starting to use Pivot Tables, it is important to understand the concept of grouping.

Consider the list below of fictional office staff:

<table>
<thead>
<tr>
<th>Name</th>
<th>Gender</th>
<th>Eye Colour</th>
</tr>
</thead>
<tbody>
<tr>
<td>Barnsey</td>
<td>Male</td>
<td>Blue</td>
</tr>
<tr>
<td>Tezza</td>
<td>Female</td>
<td>Brown</td>
</tr>
<tr>
<td>Kazza</td>
<td>Female</td>
<td>Hazel</td>
</tr>
<tr>
<td>Davo</td>
<td>Male</td>
<td>Blue</td>
</tr>
</tbody>
</table>
There are 10 records in the list. The name column identifies individuals, but the gender and eye colour columns do not.

The name column means we must have one record per individual.

For analysis purposes we may not need to know the names of individuals, so we can group the data and count the records for each entry:

<table>
<thead>
<tr>
<th>Grouping based on Gender:</th>
<th>Grouping based on Eye Colour:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gender Count</td>
<td>Eye Colour Count</td>
</tr>
<tr>
<td>Female</td>
<td>4</td>
</tr>
<tr>
<td>Male</td>
<td>6</td>
</tr>
<tr>
<td>Total</td>
<td>10</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Total</td>
</tr>
</tbody>
</table>

Now, instead of 10 rows, we have 2 rows for Gender and 4 rows for Eye Colour (but we can no longer see which individual is which gender or eye colour). To add more value, we can construct different groupings of eye colours and genders, summing the number of records at each intersection:

<table>
<thead>
<tr>
<th>Eye Colour</th>
<th>Gender</th>
<th>Count</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blue</td>
<td>Female</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>Male</td>
<td>4</td>
</tr>
<tr>
<td>Brown</td>
<td>Female</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>Male</td>
<td>1 OR Brown</td>
</tr>
<tr>
<td>Hazel</td>
<td>Female</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>Male</td>
<td>1 Green</td>
</tr>
<tr>
<td>Green</td>
<td>Female</td>
<td>1 Total</td>
</tr>
<tr>
<td></td>
<td>Male</td>
<td>0</td>
</tr>
<tr>
<td>Total</td>
<td>10</td>
<td></td>
</tr>
</tbody>
</table>

Importantly, in every case the total number of records equals 10.

We would not usually group on the names because this would not summarize our data. We would still end up with 10 rows.

⇒ Open the Basic Pivot table on the AEI website
Structure of a Pivot Table

Diagram 1—Structure of a Pivot Table

The following points refer to the example above.

Fields

- In the pivot table you will see a series of fields, such as Month, State, Nationality, Sector, Year and Sum of DATA YTD Enrolments.
- Within the fields are Items. For example the items of the field called Sector are:
  - ELICOS
  - Schools
  - VET
  - Higher Education
  - Other
- Fields enable the data to be either filtered or summarised.
- There must also be at least one data field in the table to provide the numbers for the summary. In the example above it is DATA YTD Enrolments.
- All of the fields can be moved with the mouse to different areas in the pivot table to give different summaries of the data.
- Clicking the down-arrow at the right of the field name will reveal the item selector of the field, showing the items that make it up.
Page Area
- Bright Yellow highlight in diagram 1
- The page area is used to locate the fields used for filtering the data.
- It can also be used as a convenient place to locate fields not currently being used (also see the Pivot Table Field List).
- When viewing the items of a field that is in the Page Area, only one item can be selected for filtering.

In the example above the Month, State and Nationality fields are in the PAGE area and the Month field has been set to Aug. This filter is reflected in the numbers in the data area.

Data Area
- Green highlight in diagram 1
- This area contains the numeric summaries determined by the organisation of the fields in the row, page and column areas.
- In the examples above the data field is DATA YTD Enrolments
- The type of summary used in the example is SUM, giving: Sum of DATA YTD Enrolments.
- See below for more way to summarised the data.

IMPORTANT
When using AEI pivot tables, data fields are prefixed by the word DATA. These are the only fields that should be placed in the data area.

Row Area
- Pale Yellow highlight in diagram 1
- The items of fields placed in the row area will be displayed and the summaries created will form the rows of the data area.
- In the example above the Sector field is in the row area.
- For fields in the row area, when the items are revealed, selection boxes appear next to each item enabling selection of specific items.

Column Area
- Blue Yellow highlight in diagram 1
- The items of fields placed in the column area will be displayed and the summaries created will form the columns of the data area.
- In the example above the Year field is in the row area.
- The same item selection rules apply to fields in the row area and column areas.
- Note that in Excel 2003 and previous versions, the maximum number of columns is 256. If you try to add a field with more than 255 items to the
column area, the following dialogue box will appear:

![Image of warning dialogue box]

- In this case the data will not be very useful or readable. You should reorganise the fields so the data is more usefully displayed.

**Pivot Table Field List**

Not all available fields need to be shown in the Page, Row, Column or Data areas. To simplify using the pivot table, only those fields currently being used need to be displayed.

- A full list of all the fields available can be seen in the **Pivot Table Field List**.
- To open the Pivot Table Field List:
  - Hover over the pivot table with the mouse pointer and right-click to reveal the Pivot Table Sub-Menu
  - Select **Show Field List**
- Fields that are currently displayed on the pivot table are shown in bold
- Fields that are not displayed are shown in normal font
- To display a field not already on the pivot table:
  - Use the mouse to select the field from the Pivot Table Field List
  - Drag/Drop it to the appropriate area on the pivot table
  - The field will now be shown in bold in the field list

- To remove a field that is currently displayed on the pivot table:
  - Select the field to be removed with the mouse
  - Drag it out of the pivot table area until you see a red X beside the mouse icon
  - Drop the field icon
  - The field will now appear in the Pivot Table field List in normal font.

- The Pivot Table Field List can be locked to the sides of the screen. Drag the box to the left or right and when positioned correctly it will snap to the side and expand out. In this position it will remain displayed while a cell in the pivot table is selected.
Identify the Page, Row, Column, Data Areas on the AEI Basic Pivot table, and open the Pivot Table Field List.

Using Fields to summarise data

Moving Fields
- Fields in any part of the pivot table can be moved to any other part of the pivot table.
- To move fields simply select them with the mouse and drag/drop them in the new location.
- When you move fields around, you will see the cursor change indicating the area into which the field is to be dropped.
- Be careful where you locate data fields—they should only be in the data area.

Stacking Fields
- Fields can be stacked in the row or column areas, enabling more complex summaries of the data
- To stack fields, select the fields and drag/drop them in the appropriate area.
- You can stack several fields in the row and/or column areas, but stacking too many fields can make the data difficult to read.
- In the example below, the **State** (blue highlight) and **Sector** (yellow highlight) fields are **stacked** in the Row Area, providing a breakdown of enrolments data by State and Sector (Row) and Year (Column), for year-to-date August (Page Area).

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
<th>I</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Month</td>
<td>Aug</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Nationality</td>
<td>(All)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Sum of DATA YTD Enrolments</td>
<td>Year</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>State</td>
<td></td>
<td>Sector</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>NSW</td>
<td></td>
<td>ELICOS</td>
<td>19,944</td>
<td>18,759</td>
<td>18,861</td>
<td>19,285</td>
<td>22,986</td>
<td>31,642</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Schools</td>
<td>6,946</td>
<td>8,318</td>
<td>8,584</td>
<td>7,488</td>
<td>7,030</td>
<td>7,905</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>VET</td>
<td>23,233</td>
<td>24,860</td>
<td>25,622</td>
<td>26,316</td>
<td>34,719</td>
<td>48,549</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Higher Education</td>
<td>39,164</td>
<td>45,353</td>
<td>51,779</td>
<td>57,297</td>
<td>59,418</td>
<td>60,984</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Other</td>
<td>8,476</td>
<td>9,056</td>
<td>8,983</td>
<td>8,864</td>
<td>8,498</td>
<td>8,721</td>
</tr>
<tr>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>NSW Total</td>
<td></td>
<td></td>
<td>97,763</td>
<td>106,346</td>
<td>113,769</td>
<td>121,250</td>
<td>132,661</td>
<td>157,801</td>
</tr>
<tr>
<td>12</td>
<td>VIC</td>
<td></td>
<td>ELICOS</td>
<td>9,177</td>
<td>10,973</td>
<td>11,239</td>
<td>10,367</td>
<td>12,026</td>
<td>16,284</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Schools</td>
<td>6,715</td>
<td>7,864</td>
<td>7,838</td>
<td>7,122</td>
<td>6,721</td>
<td>7,444</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>VET</td>
<td>11,554</td>
<td>11,621</td>
<td>12,046</td>
<td>14,632</td>
<td>20,175</td>
<td>33,735</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Higher Education</td>
<td>36,382</td>
<td>42,314</td>
<td>47,077</td>
<td>49,863</td>
<td>51,768</td>
<td>54,049</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Other</td>
<td>5,681</td>
<td>5,620</td>
<td>5,444</td>
<td>5,450</td>
<td>5,686</td>
<td>6,115</td>
</tr>
<tr>
<td>17</td>
<td>VIC Total</td>
<td></td>
<td></td>
<td>68,499</td>
<td>76,392</td>
<td>83,704</td>
<td>87,434</td>
<td>96,368</td>
<td>115,627</td>
</tr>
<tr>
<td>18</td>
<td>Grand Total</td>
<td></td>
<td></td>
<td>166,172</td>
<td>184,738</td>
<td>197,473</td>
<td>208,654</td>
<td>223,009</td>
<td>277,428</td>
</tr>
<tr>
<td>19</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>20</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Filtering Data

Fields in the PAGE area can be used to filter the data. For example you may just want to analyse data for one particular sector.

To apply a filter, do the following:

- Make sure the field to be filtered is in the Page Area
  (If the Sector field is not in the page area, use the mouse to drag it there)
- Click the down-arrow at the right of the field box.
  This will reveal the items of the field.
  Because the field is in the page area, only one item can be selected
- Click the item to be filtered on, and click OK
- The data and summaries will now reflect the filter applied
- The field will show the value of the filter applied
- To remove the filter, follow the same procedure, but select (All).
- In the example below you can see that the items of the Sector field are (All) and ELICOS, Schools, VET, Higher Education and Other. Higher Education is selected and this is reflected in the Sector field on the pivot table.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
<th>I</th>
</tr>
</thead>
<tbody>
<tr>
<td>Month</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sector</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Nationality</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sum of DATA YTD Exams</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Year</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>NSW</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>VIC</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>QLD</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SA</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>WA</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TAS</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>NT</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ACT</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Grand Total</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Selecting Data

When fields are displayed in the row or column areas you can use the Item Selector to limit what data is displayed. This is similar to applying a filter, but you can select more than one item from the field to display.

- The Item Selector is a good way to see what items are contained within a Field, if the filed name is ambiguous
- In the example below, the Sector field items are shown with just ELICOS and VET selected
- When specific selections are made the summaries in the data area and grand totals reflect these selections
• The (Show All) option enables you to over-ride an existing selection. Clicked once it will SELECT ALL items. Clicked a second time it will DE-SELECT ALL items.

• The example below shows the items of the Sector field with just ELICOS and VET selected and displayed.

![Image of spreadsheet with Sector field selected]

**IMPORTANT**

- If you make a selection of items in a field that is in the row or column area, and then MOVE this field to the Page Area, the selection will be retained and the data will be filtered based on this.

- In the example above if the Sector field is moved to the Page Area, the selection (ELICOS and VET) will be retained and the data and summaries displayed will reflect this.

- The Sector page field item will show **(Multiple Items)**.

- To change the selection of items or to include all items, you must move the field to the row or column area and open the item selector to make your new selection.

![Image of spreadsheet with Sector field moved to Page Area]
**Drill Through**

Drill Through enables you to view the raw data that makes up the summaries on the screen. This is especially useful if you are using the Standard or Detailed pivot tables from the AEI website.

To drill through, select a number in the pivot table and double click on it. A new worksheet will open with the raw data.

**Sorting Items and Data**

It is often convenient to sort items in different ways. For example you may want to sort Nationality alphabetically, or by the number of enrolments.

To sort items by name:
- Locate the field to be sorted in the row or column area
- Select one cell in the item list
- Click the sort buttons in the menu at the top of the screen to sort the items based on their name:

To sort items by data values:
- Locate the field to be sorted in the row or column area
- Select one cell in the data area
- Click the sort buttons in the menu at the top of the screen to sort the items based on their data values:

**Grouping Items**

You may wish to group part of an item list, and view the remaining items as individual items.

For instance you may wish to look at data for New South Wales, Victoria and Queensland as individual states, but group all the other states into a single item, and show aggregate data for the group.

When items are grouped like this, the data aggregates based on the groupings.

To group items:

- Locate the field containing the items to be grouped in a row or column area. For this example use Row Area
- Using the mouse and holding down the Ctrl key, select the items to be grouped. In the example above, this would be Western Australia, South Australia, Australian Capital Territory, Tasmania and the Northern Territory
Right-click in the selected cells and select **Group and Show Detail** ⇒ **Group...**

The table now has a new field called **State2** added:
- In the **State2** field the grouped states are collectively shown as **Group1**
- Aggregations in the data area reflect the grouping
- The **State** field remains in the **Row Area**. This can be moved to the Page Area

See the example below:

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
<th>I</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Month</td>
<td>Aug</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Sector</td>
<td>(All)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Nationality</td>
<td>(All)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>State</td>
<td>(All)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Sum of DATA YTD Enrolments</td>
<td>Year</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>State2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>NSW</td>
<td>97,763</td>
<td>105,345</td>
<td>113,769</td>
<td>121,250</td>
<td>132,851</td>
<td>157,801</td>
<td>185,552</td>
</tr>
<tr>
<td>9</td>
<td>VIC</td>
<td>69,409</td>
<td>78,392</td>
<td>83,704</td>
<td>87,434</td>
<td>96,398</td>
<td>115,827</td>
<td>142,393</td>
</tr>
<tr>
<td>10</td>
<td>QLD</td>
<td>38,634</td>
<td>44,469</td>
<td>48,396</td>
<td>49,904</td>
<td>53,591</td>
<td>59,004</td>
<td>72,318</td>
</tr>
<tr>
<td>11</td>
<td>Group1</td>
<td>42,689</td>
<td>49,518</td>
<td>52,111</td>
<td>55,157</td>
<td>58,655</td>
<td>63,941</td>
<td>73,728</td>
</tr>
<tr>
<td>12</td>
<td>Grand Total</td>
<td>247,695</td>
<td>278,724</td>
<td>297,953</td>
<td>313,745</td>
<td>341,155</td>
<td>400,373</td>
<td>474,389</td>
</tr>
<tr>
<td>13</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

⇒ **Using the AEI Basic Pivot Table, practise moving and stacking fields, filtering and selecting data, drilling through, sorting by item lists and data values.**

**Summarising Data in Pivot Tables**

There are many ways to summarise the data in a pivot table. As well as simple aggregations of data, you can find differences, percentages, contributions and more.

You can concurrently show different kinds of summaries for the same data field. For example you can show the year to date enrolment volumes, the change on the previous year, and the percentage change.

We will investigate how to use different types of summaries in the exercise below.

⇒ **EXERCISE 1**

**Use the AEI Basic Pivot Table to show Year-to-Date Enrolments, Differences from Previous Year and Percentage Growth, by Sector and Year:**

1. Close and re-open the AEI Basic Pivot Table

2. Organise the table as follows:
   - Month, Sector, State and Nationality fields are in the **Page Area**.
   - The Year field is in the **Column Area**
The DATA YTD Enrolments field is in the **Data Area**

3. The DATA YTD Commencements field is not displayed (Open the Data item selector, click the item called **Sum of Data YTD Commencements** to de-select it and click OK)

4. Check that the Month field has a filter for the current month applied

5. Open the Pivot Table Field List (right click in the data area ⇒ Show Field List)

6. Drag the field called **DATA YTD Enrolments** into the **data area**

7. Repeat step 6

8. Drag the Data field to the **Row Area**. Your pivot table should now look like this (the Month filter and data may be different):

   ![Pivot Table]

9. Right-click on the cell called **Sum of YTD Enrolments2** and select Field Settings.
   The PivotTable Field dialogue box opens.
10. In the Name: box type “Growth”

11. Click the Options >> button
    This reveals the Show data as: component

12. Click the drop-down button (currently set to Normal)

13. Select “Difference From” from the “Show data as” box

14. Select Year from the Base field box

15. Select (Previous) from the Base item box

16. Click OK

17. Right-click on the cell called Sum of YTD Enrolments3 and select Field Settings
    The PivotTable Field dialogue box opens

18. In the Name: box type “% Growth”

19. Click the Options >> button
    This reveals the Show data as: component
20. Click the drop-down button (currently set to Normal)

21. Select “% Difference From” from the “Show data as” box

22. Select Year from the Base field box

23. Select (Previous) from the Base item box

24. Click OK.

Your pivot table should now look like this (the Month filter and data may be different):

<p>| | | | | | | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Month</td>
<td>Aug</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Sector</td>
<td>(All)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>State</td>
<td>(All)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Nationality</td>
<td>(All)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

25. Finally, move the Sector field into the row area, to the left of the Data fields to break the data down by sectors.

Your pivot table should now look like this (the Month filter and data may be different):

<p>| | | | | | | | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Month</td>
<td>Aug</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>State</td>
<td>(All)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Nationality</td>
<td>(All)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Sector</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Data</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Year</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Sum of DATA YTD Enrolments</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Growth</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>% Growth</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
The table now shows:

- Enrolment volumes (**Sum of Data YTD Enrolments**)
  - Volume growth on the previous year (**Growth**)
  - Percentage growth on the previous year (**% Growth**)
- For year to date August of each year displayed (**Month filter = “Aug”**)
- By Sector and Year (no filters applied to these fields)

### Creating and using Pivot Charts

Pivot Charts are a powerful and flexible way of visually representing data contained in pivot tables. The look and feel of the chart can be changes and the fields represented in the chart can be dragged and dropped, and filtered in the same way as in the pivot table.

Pivot Charts are linked to pivot tables. They are usually created in a separate worksheet in the pivot table file.

We will investigate how to use different types of summaries in the exercise below.

⇒ **EXERCISE 2**

**Create a Pivot Chart to show Year-to-Date Enrolments by Year and Sector:**

1. Close and re-open the AEI Basic Pivot Table
2. Organise the table as follows:
   - Month, State and Nationality fields are in the **Page Area**.
   - The Year field is in the **Column Area**.
   - The Sector field is in the **Row Area**.
   - The DATA YTD Enrolments field is in the **Data Area**.
   - The DATA YTD Commencements field is not displayed (Open the Data item selector, click the item called **Sum of Data YTD Commencements** to de-select it and click OK)
3. Check that the Month field has a filter for the current month applied.
4. Your pivot table should now look like this (the Month filter and data may be different):

![Pivot Table Image]

5. Now the data for the chart is set up.

Next notice the Pivot Table tool bar:

![Pivot Table Tool Bar Image]

You may have to click inside the pivot table to expose the Pivot Table tool bar.

If you cannot see it, go to the top menus in Excel and select:
**View** ⇒ **Toolbars** ⇒ **PivotTable**

6. Select one cell inside the pivot table, and click the chart icon ⇒
7. The chart is displayed in a new worksheet. Your pivot chart should now look like this (the Month filter and data may be different):

8. Notice that the fields are represented in the chart with the same drop-down arrows to the right hand side.
   - The Month, Nationality and State fields are in the **Page Area** of the chart and can be used for filtering the data.
   - The DATA YTD Enrolments field is in the **Data Area** and the summary type is set to **Sum**.
   - The Sector field is providing values for the **X axis**.
   - The Year field is providing the breakdown within each sector value. A legend is automatically generated.

9. The chart is of limited use as currently set up. To make it more useful:
   - Drag/drop the Year field to the right of the Sector field. The chart will change in appearance.
   - Drag/Drop the State field to where the year was.
10. Your pivot chart should now look like this (the Month filter and data may be different):

We now have a chart showing Enrolment Growth as at Year-to-date August, by Year and Sector, with a breakdown by State. We can see from this that:

VET sector enrolments are growing quickly
ELICOS enrolments are also growing, but at a slower rate and from a smaller base
Higher Education enrolments are growing at a decreasing rate
Schools and Other sector enrolments are relatively stable

To finish the exercise, manipulate the fields to determine which state is growing the fastest.

This is a very brief summary of how to use Pivot Charts. There are many other things you can do such as change the chart type, show 2 types of summary on the same chart, manipulate colours, use calculated fields and more.

Interpreting Data in Pivot Tables

Understanding the fields in a pivot table is a critical aspect of their successful use. Invalid interpretations of data can occur when field are not properly understood.
This is particularly the case when using the data fields in the AEI pivot tables. The data fields are aggregated each month through the year. So the March Enrolment and Commencements data is the sum of the January, February and March data.

So you would not sum the year-to-date enrolments or commencements data over 2 months (say July and August) because you would them be adding together the data from January to July AND January to August, giving a highly inflated result.

Therefore in most cases you would locate the Month field in the Page Area, and filter on the month required. For year to date information it would be the month of the most recent data update. For calendar year data you would set the month to December. In this case you would not see any data for the current year.

Looking at the fields we have we have used so far:

<table>
<thead>
<tr>
<th>Type</th>
<th>Field Name</th>
<th>Interpretation</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Month</td>
<td>The month in which the enrolments occurred</td>
</tr>
<tr>
<td></td>
<td>Sector</td>
<td>The sector in which the enrolments occurred</td>
</tr>
<tr>
<td></td>
<td>State</td>
<td>The state in which the enrolments occurred</td>
</tr>
<tr>
<td></td>
<td>Nationality</td>
<td>The nationality of the students enrolling</td>
</tr>
<tr>
<td></td>
<td>Year</td>
<td>The year in which the enrolments occurred</td>
</tr>
<tr>
<td></td>
<td>Sum of YTD Enrolments</td>
<td>The number of enrolments from 01 January to the end of the reference month in the reference year.</td>
</tr>
<tr>
<td></td>
<td>Growth</td>
<td>This is the difference between the enrolments in one year and enrolments in the previous year.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>There is no figure for 2002 because there is no data for years prior to 2002.</td>
</tr>
<tr>
<td></td>
<td>% Growth</td>
<td>This is the percentage difference between the enrolments in one year and enrolments in the previous year.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>There is no figure for 2002 because there is no data for years prior to 2002.</td>
</tr>
</tbody>
</table>
Copying Data from Pivot Tables

It is often useful to copy data summaries from a pivot table to another excel file for archiving, presentation or further analysis.

Care should be taken when copying data from a pivot table to another spreadsheet, especially if the new spreadsheet is to be subsequently emailed.

Depending on how you copy and paste the data, you can inadvertently copy all the data underlying the pivot table as well, which will increase the size of the excel file many-fold, although you may not be able to see the data.

To copy data from a pivot table to another excel file:

1. Select a single cell in the table and right-click

2. Choose Select ⇒ Entire Table

3. Press Ctrl + C on your computers keyboard

4. Navigate to desired cell in the destination excel file

5. Select Edit ⇒ Paste Special from the top menu, select Values and number formats and click OK
The data values will be pasted as unformatted values. The underlying data will not be pasted resulting in a smaller destination file.

See the result below:

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
<th>I</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Month</td>
<td>Aug</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Region</td>
<td>(All)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Nationality</td>
<td>(All)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Level Of Study</td>
<td>(All)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Broad Field Of Education</td>
<td>(All)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>ProviderType</td>
<td>(All)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>State</td>
<td>(All)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Broad Field Of Study</td>
<td>(All)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>DATA As at 1st Month</td>
<td>(All)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>DATA Enrolments For Month</td>
<td>(All)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Data Commencements for Month</td>
<td>(All)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Sum of DATA YTD Enrolments</td>
<td>Year</td>
<td>2002</td>
<td>2003</td>
<td>2004</td>
<td>2005</td>
<td>2006</td>
<td>2007</td>
<td>2008</td>
</tr>
<tr>
<td>15</td>
<td>Higher Education</td>
<td></td>
<td>112,563</td>
<td>131,745</td>
<td>147,723</td>
<td>159,516</td>
<td>165,964</td>
<td>171,392</td>
<td>179,136</td>
</tr>
<tr>
<td>16</td>
<td>VET</td>
<td></td>
<td>47,201</td>
<td>50,207</td>
<td>51,471</td>
<td>57,506</td>
<td>70,028</td>
<td>102,655</td>
<td>147,073</td>
</tr>
<tr>
<td>17</td>
<td>ELICOS</td>
<td></td>
<td>44,294</td>
<td>47,358</td>
<td>48,527</td>
<td>48,493</td>
<td>56,735</td>
<td>75,793</td>
<td>92,621</td>
</tr>
<tr>
<td>18</td>
<td>Schools</td>
<td></td>
<td>21,567</td>
<td>25,335</td>
<td>28,931</td>
<td>23,879</td>
<td>23,028</td>
<td>25,181</td>
<td>27,541</td>
</tr>
<tr>
<td>19</td>
<td>Other</td>
<td></td>
<td>22,070</td>
<td>24,079</td>
<td>24,201</td>
<td>24,347</td>
<td>24,479</td>
<td>25,352</td>
<td>28,012</td>
</tr>
<tr>
<td>20</td>
<td>Grand Total</td>
<td></td>
<td>247,695</td>
<td>278,724</td>
<td>297,953</td>
<td>313,745</td>
<td>341,155</td>
<td>400,373</td>
<td>474,389</td>
</tr>
</tbody>
</table>

This method also the advantage that fields in the page area of the source file are copied across with the data, so users can see what filters are applicable to the data.